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第1章 序論 

1.1 研究背景 

現在、ほぼ全ての製造産業（車両、電機、航空、精密機器等）において、CFD 技術

が普及しており、各業界において、程度の差はあるものの CFD の技術が上記の役割

を果たしているといえる[1]。今後、CFD 技術は現場において更なる大規模化、高速化

が求められている。高精度化、より複雑な解析モデル（現象・形状）への対応、高速

化の 3 点は特に重要性が高まっている。 

CFD の重要性は製造産業に留まらず、モータースポーツ最高峰の Formula 1
TMのマ

シン開発でも多用されている。世界的な経済不況に伴い各チームの研究開発・運営コ

ストを削減する向きがあり、その反面スポンサーの獲得やチャンピオンシップ獲得を

目標として戦闘力の高いマシンを設計する必要がある。風洞実験から得られるデータ

は実現象を再現する努力がなされている為信頼性は高いが、コストが非常に高くなる。

コスト制限協定導入前の 2008 年は、有力チームは少なくとも 2 基の風洞を持ち、設

備だけで 4000 万ドル以上を費やしていると言われている。また、これら設備は 1 日

24 時間年中無休で稼働しており、60～80 人のスタッフが 3 交替制で作業に従事して

いる為、ランニングコストだけでも年間 2000 万ドルを超えると言われている。

Vodafone McLaren Mercedes を例に取ると、最大負荷での稼働時は毎秒 200 リットルの

冷却水を必要とし、電力消費はウォキング市街地全体の電力消費に匹敵すると言われ

ている[2]。この事からも、コスト・低スペースの CFD は今迄以上に重要性が高まって

いる。 

個々の製品や現象では、現象や解析体系のモデル化による計算コスト低減がひとつ

の解であるが、大きな視点で考えると、上記の要求を満足する為には計算コストが増

加する傾向にある。従って、ものづくりの現場における流体解析においては HPC（High 

Performance Computing）技術を駆使した大規模流体解析の重要性が増す。 

そこで注目される物が「スーパーコンピュータ」である。スーパーコンピュータ利

用の大きな目的は、世界トップクラスのスーパーコンピュータを開発・活用すること

により、科学技術のブレイクスルーを実現し、国際競争力を強化するところにある。

もう一つの重要な目的が、スーパーコンピュータを駆使して、科学技術を推し進める

人材の育成である。世界トップレベルの「次世代スーパーコンピュータ」の構築は、

世界最高レベルの研究開発環境の構築とも言い換える。そこには、「次世代スーパー

コンピュータ」を駆使し、新たな科学技術の扉を開けようと世界のトップレベルの科

学者、技術者が集まってきた。地球温暖化のメカニズムの解明、持続可能な環境保全

型の経済活動の実現など、21 世紀の課題を解決するには、分野を超えた科学技術が集

結し、さらに、それら技術の融合を必要としている。そのためにも、世界中の優れた
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研究者が集い、それぞれの知見と英知を共有する優れた研究環境の構築が急がれてい

る[3]。 

現在、最先端の解析では要素数 10
10程度の解析が行われている[4]。これに対し、本

研究室では Table 1.1 の「Meisa」が最高スペックであった。一般に、1 コアで要素数

10
6の解析を行えると言われており、理論上 8Core を搭載する Meisa では 8×10

6の解

析を行う事が出来た。 

ところが 2012 年度より、本研究室では東京大学所有のスーパーコンピュータ「FX10

（Oakleaf-FX）」を使用出来る環境を得た。FX10 は Table 1.2 に挙げられている様に本

学の契約では 192 コアが使用可能であり、これにより理論上では要素数 192×10
6解析

を行える様に成った。また、Table 1.3 に示されるワークステーション「Aventador」導

入により、メッシュ生成は要素数 12
6迄可能に成った。FX10 使用契約料は 25 万円、

Aventador の購入代金は約 23 万円、メッシュジェネレータ及び可視化ソフトは其々約

百万円である事から、これは中小規模の企業でも導入出来る程度の設備であると言え

る。 

本研究室において 12
6規模の解析を行える様に成ると、研究の一貫として行った実

験を元に最適化解析をし、実験では不可能な規模の事象を解析する事が出来る様に成

る。また、企業からの委託研究において、受託出来る事例の規模が増加し研究開発の

幅が増す事で、本研究室の社会的有用性が高まる。これにより、今後本研究室で学ぶ

学生の研究レベルも向上し、社会で活躍する事が出来る人材を輩出する事も可能と成

る。 

しかし、本研究室において中小企業が行う解析規模等を超えられなかった原因は、

解析技術や独特のカンといったノウハウが無い為である。この事から、本研究室のリ

ソース全てを用いて行う事が出来るノウハウ等を追及する必要がある。 

そこで着目すべき点は解析格子（メッシュ）である。正確な解析を行うためには細

かいメッシュ、構造格子の直交性や非構造格子の形状の良さが要求される。しかし、

PC の能力を考慮せずに処理を行うと収束までに掛かる時間が非常に長く成る為に注

意する必要がある。 
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Fig.1 : 東京大学所有スーパーコンピュータ FX10 (Oakleaf-FX) 

 

Table 1.1 : 解析サーバー「Meisa」スペック及び準備費用 

CPU Intel Xeon X5500 2.93GHz ×2 

プロセッサ数 8 processor 

メモリ 48Gbyte 

ハードディスク 10Gbyte 

オペレーティングシステム Linux 

準備費用 80 万円 

 

Table 1.2 : 東京大学所有「FX10 (Oakleaf-FX)」スペック及び年間使用料 

CPU SPARC 64 Ⅸfx 1.848GHz ×12 

プロセッサ数 192 (12×16) processor 

メモリ 348Gbyte 

ハードディスク 50Gbyte 

オペレーティングシステム Linux 

年間使用料(個人契約) 25 万円 
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Table 1.3 : メッシュ生成用 PC「Aventador」スペック及び準備費用 

CPU Intel Core i7 3.07GHz 

プロセッサ数 8 processor 

メモリ 24Gbyte 

ハードディスク 1Tbyte 

オペレーティングシステム Windows 7 64-bit 

準備費用 23 万円 

 

1.2 研究目的 

 一般に、1 コアで 10
6 メッシュの解析を行えると言われている。この事から、本研

究室で使用出来る Oakleaf-FX の最大コア数 192 を元に、10
8オーダーのメッシュ数に

おける解析を正しく扱う事を目指す。目標は以下の 3 点である。 

・10
8オーダーのメッシュを生成する。 

・10
8オーダーのメッシュの解析を行う。 

・10
8オーダーのメッシュの可視化及び解析結果の妥当性を検証する。 
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第2章 解析手法 

2.1 研究目標 

本研究室で使用する事が出来るリソースを以て 10
8オーダーの解析を実行出来る様、

以下の方針で研究を行った。 

 

2.1.1 研究方針 

第一段階として、形状が簡素且つ多くの要素数を必要としない船舶三種の抵抗係数

解析を行い、参考値と抵抗値を合致させる事で小規模解析の基礎ノウハウを得る。 

第二段階として、第一段階で得たノウハウを元に 10
8オーダーのメッシュを生成、

解析、可視化し、解析の妥当性を検証する。 

解析で使用した乱流モデルは RANS の k-ωSST モデルである。 

 

2.1.2 評価方法 

解析の妥当性に関する評価方法は、抵抗係数の参考値と解析値を比較する事で評価

する。船舶三種は10
-4オーダーを、Audi TTは参考値に対して±0.1を許容範囲とした。 
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2.2 解析対象 

2.2.1 船舶三種 

第一段階として、2006 年に独立行政法人 海上技術安全研究所で行われたワークシ

ョップ「CFD Workshop Tokyo 2005」において、解析対象として挙げられた Fig.2.1～

2.3 の船舶三種の抵抗係数解析を行った。Table 2.1 は船舶各種の抵抗係数である。 

 

 

Fig.2.1 : KRISO Container Ship (KCS) 

 

 

Fig.2.2 : Modified KRISO Tanker (KVLCC2M) 

 

 

Fig.2.3 : US Navy Combatant, DTMB 5415 

 

Table 2.1 : 抵抗係数参考値[8]
 

船舶名 抵抗係数  

KRISO Container Ship (KCS) 0.00356 

Modified KRISO Tanker (KVLCC2M) 0.00355 

US Navy Combatant, DTMB 5415 0.00423 
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2.2.2 自動車 

第二段階として、抵抗係数が公開されている自動車 Audi TT を解析対象として扱っ

た[5]。解析に使用した CAD データは Fig.2.4 である。また、抵抗係数の参考値は 0.3

である[13]。 

 

 

Fig.2.4 : Audi TT の CAD データ 
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2.3 使用ソフトウェア 

2.3.1 OpenFOAM 

 解析に使用したソフトウェアはOpenCFD社が開発し，GNUのGeneral Public License

のライセンスの下でフリー配布されている OpenFOAM を使用する．船舶三種の解析

では OpenFOAM-2.0.1 を，Audi TT の解析では OpenFOAM-2.1.0 を使用した． 

OpenFOAM は他の商用ソルバとは異なり，ライセンスによる並列数制限が無く，解

析規模と解析リソースの規模に合わせて自由に並列化させる事が出来る． 

 

2.3.2 Pointwise 

 メッシュ生成に用いたソフトウェアは、米国 Pointwise 社が開発し、株式会社 VINAS

がライセンス販売等を代行している Pointwise を使用した。Pointwise は先代 Gridgen

で培ったメッシュコントロール技術に加え、Pointwise のみに与えられた「境界層メッ

シュ自動生成機能」等も併せ持つソフトウェアである。Pointwise で生成する事が出来

る境界層メッシュは表面直行性が良く、解析の収束時間短縮に貢献する。適用事例は

幅広く、航空宇宙、重工・造船、電機、化学、医療等の様々な分野で利用されている

ソフトウェアである。また、OpenFOAM 等のオープンソースソルバにも対応してい

る[6]。 

 

2.3.3 Fieldview 

可視化段階で使用したソフトウェアは、米国 Intelligent Light 社が開発し、株式会社

VINAS がライセンス販売等を代行している Fieldview である。Fieldview は高度な工学

評価機能と直感的で簡単な操作性により複雑な流体現象を素早く把握する事が出来

るソフトウェアである。Fieldview の適用事例は Pointwise と同様で、幅広く用いられ

ている。また、Fieldview も OpenFOAM 等のオープンソースソルバに対応している[7]。 

 

2.3.4 使用ハードウェア 

本研究において使用したハードウェアは 1 章（序論）に挙げる Table 1.1～1.3 であ

る。メッシュ生成及び可視化は Table 1.3 の「Aventador」を、船舶三種の解析は Table 

1.1 の「Meisa」を、Audi TT は Table 1.2 の「FX10 (Oakleaf-FX)」を使用した。 
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2.4 数値解析手法[9]
 

2.4.1 有限体積法 

有限体積法(Finite Volume Method)は、保存方程式の積分形から導出される。解析域を

有限個の隣接するコントロールボリュームに分割し、保存方程式をそれぞれのコント

ロールボリューム体積に対して適用する。それぞれのコントロールボリュームの中央

に格子点を定義し、そこに計算されるべき変数が配置される。ボリューム界面での値

をコントロールボリューム中心値で表す場合には補間が用いられる。面積分、体積積

分は適当な求積法を用いて近似される。結果として各コントロールボリュームに対し

て 1 つの代数方程式が得られ、そこには隣接コントロールボリュームの値が現れる。 

有限体積法はどの様なタイプの格子にも適応出来るので複雑形状に対しても適合す

る。格子はコントロールボリューム境界のみを定義しており、必ずしも座標系に関係

づけられなくとも良い。この手法は面積分(移流項と拡散項の流束を表す)が 2 つのコ

ントロールボリュームの共有する境界について同じ値を持つ限り自動的に保存的と

なる。 

有限体積法の差分法に対する短所は 2 次よりも高い制度の方法を 3 次元で実現する

のが難しい点である。これは有限体積法が 3 段階の近似即ち補間、微分そして積分を

必要とするからである。 
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2.4.2 風上差分法 

セル界面 e の上流計算店の値によってφe を近似することは、1 次関数を求めるため

に(流れの方向に依存して)後進若しくは前進差分近似を用いることと同等である。よ

て、この近似を風上差分スキーム(Upwind Difference Scheme)と呼ぶ。風上差分スキー

ムにおいてφe は以下で近似される。 

 

 
これは無条件に有界性を満足する唯一の近似であり、決して振動解を伴わない。し

かし、以下で示すように風上差分法は数値的拡散を生じる。 

デカルト座標格子において の時、点 P 近傍のテーラー級数展開は式(2.1)

の様になる。 

 …(2.1) 

ここで H は高次の項を表す。風上差分近似は右辺の初項だけを用いる 1 次精度スキー

ムである。主要打ち切り誤差項は拡散的であり、具体的には式(2.2)の様な拡散流束を

表している。 

 …(2.2) 

これを数値拡散(人口拡散、疑似拡散)とみなすと、その係数は であ

る。多次元問題において流れが格子に対して斜行している時には、数値拡散は流の方

向だけでなく流れに垂直な方向にも拡散を生じ、この問題特有の大きな誤差を引き起

こす。結果として、変数の極値や変化の急勾配が不鮮明になる傾向を生じ、たま、誤

差現象が1次オーダーでしかないため精確な解を得る為には極めて細かい格子分割が

要求される。 
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2.4.3 圧力項及び体積力の離散化 

通常圧力は として取り扱われる。非圧縮性流体では最終項は 0 である。運動方程

式 の式中にはこの量の勾配を含んでいて 3章で示した有限差分法等によって近似さ

れる。ところが、格子上での圧力と流速の定義店が一致しない場合もあるため、微分

に対して使われる近似は違うものとなる。 

有限体積法では圧力項は面積力（保存形式）として扱われる為、ui の方程式で積分 

 …(2.3) 

が使われる。以下に見るように、この項の取り扱いと格子状の変数の配置は計算の効

率と数値解放の制度を保証するのに重要である。 

代わりに、圧力を子非保存形式で取り扱う事も出来、上記の積分を体積積分に直し、

式(2.4)の様に成る。 

 …(2.4) 

この場合、微分(非直行格子に対しては全ての 3 つの微係数成分)がコントロールボリ

ューム内で複数の場所で近似される必要がある。このとき、系全体として非保存形式

による誤差が生じる。格子の大きさが 0 に近づけばこの誤差は小さくなるが、有限の

格子幅では重要となる。 

保存と非保存の 2 つの定式化の違いは有限体積法でのみ重要な意味を持ち、有限差分

法ではどちらの形式での近似も使えて両差の間に大きな差は無い。 

非デカルト座標系で共変又は反変速度成分を使う時に生じる非保存項の様なみかけ

の体積力を有限差分法で取り扱う事は容易である。これらはいくつかの単純な変数の

関数である。これらの項には未知量を含む事もあり、例えば円筒座標系での粘性項の

成分には 

 …(2.5) 

が現れる。離散式の中心点の影響係数 Ap に対してこの項が正の値として寄与する時、

この項は陰的に取り扱われる。これは行列の対角成分の優位性を増して反復解放の案

的亜を図る為である。逆の場合には、余分な項は陽的に取り扱われる。 

有限体積法でこれらの項はコントロールボリュームで積分される。通常は、平均値を

用いる方法が使われ、コントロールボリュームの中心での値にセルの体積を乗する。

また場合によっては、非保存項は体積力として評価され、これは輸送方程式で支配的

な効果を持つ事もある。(旋回流が極座標で計算される時、或いは回転する座標系で

取り扱われる時、例えば流体機械内部流れが挙げられる)。この様な場合は、非線形

の生成項と変数のカップリングの取り扱いが重要となる。 
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2.4.4 対流項と粘性項の離散化 

運動方程式の対流項は非線形である。その微分形式、積分形式は式(2.6)の様になる。 

 …(2.6) 

運動量の式の対流項の取り扱いは一般保存方程式と同様である。 

次に、運動量の式の粘性項は一般保存方程式の拡散項に対応し、その微分形式、積分

形式は式(2.7)の様になる。 

 …(2.7) 

ここで非圧縮性ニュートン流体に対して、 

 …(2.8) 

である。運動方程式はベクトル方程式である為、粘性項が一般の拡散項に対してやや

複雑な形をしている。運動方程式の粘性項のうちで一般保存方程式の拡散項と一致す

る部分 

 …(2.9) 

は一般方程式で用いた手法と同様に離散化できるが、これは i 方向運動量に対する粘

性効果の一部に過ぎない。非圧縮流で流体の特性値が一定の時、これらの寄与は連続

の式によって消える。 

非圧縮流で粘性が空間的に変化する時 0でなり特別な項は式(2.9)の項と同様に取り扱

われ、 

 …(2.10) 

となる。ここで n はコントロールボリュームの界面に水力で外側への単位ベクトル、

また、j については総和規約が抵抗される。上に示した様にμが一定値ではこの項は

消去される。このため、項の陰解法を用いた時でも一般に陽的に取り扱われる。粘性

が変化する場合であっても、この項は式(2.9)に比べて小さく、この項の取り扱いは収

束率に若干の影響を与えるだけである。しかし、この事は積分形式で考える時のみ厳

密に言える事で、この項はコントロールボリュームの界面では必ずしも小さくない。 
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2.4.5 k-ωSSTモデル (RANS) 

方程式系を閉じる為には乱流モデルの導入が必要となる。そこで、どの様なモデル

が妥当であるかを考えるうえで、層流においてエネルギーの散逸や、質量、運動量、

エネルギーの流線垂直方向の輸送が粘性によって行われるという事に注目する。これ

によれば、乱れの影響を粘性を増加する事で表すことが出来るという仮定は自然であ

り、次の様な渦粘性モデルが導かれる。 

 …(2.11) 

 …(2.12) 

式(11)において、k は乱流エネルギーであり、 

 …(2.13) 

式(11)の右辺の最後の項は、縮約がとられる時に方程式が数学的に成り立つ為に必要

な項である。渦粘性の過程は、詳細に見れば必ずしも正しいものではないが、用いや

すく、また注意深く適用すれば多くの流れにおいて妥当な良い結果を得る事が出来る。

乱れはもっとも単純な表記として乱流エネルギーk 若しくは変動速度

と長さスケール L の 2 つパラメータによって特徴付けられる。次元解析を用いると以

下の関係が得られる。 

 …(2.14) 

ここで は無次元定数で、この値については後程述べる。 

最も単純な実用的なモデルである混合距離モデルでは、k は の関係を用い

て平均流れ場から与えられ、L は座標値によって予め定められた関数として与えられ

る。単純な流れ場に対しては L を正しく与える事も可能であるが、剥離を伴う流れや

3 次元性の強い流れにおいては難しく、それゆえ混合距離モデルは比較的単純な流れ

に対してのみ適用される。尚、このモデルは代数型モデル或いは 0 方程式モデルと分

類される、 

乱流統計量を予め定める事は困難であるという事から、その値を計算する為に偏微分

方程式を用いる事が提案されている。ここで速度スケールと長さスケールという少な

くとも 2 つのスケールが乱流を表すのに必要とされるので、これら 2 つの方程式に基

づくモデルが論理的であると言える。殆どすべてのその様なモデルでは、乱流エネル

ギーk の輸送方程式により速度スケールが決定される。k の正確な輸送方程式を導く

事は難しくなく、以下の様になる。 

 …(2.15) 
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この方程式の左辺の項と右辺の第 1 項はモデル化の必要が無い。また右辺の最終項は

密度ρとエネルギー散逸率εの席であり、乱流エネルギーが不可逆的に内部エネルギ

ーに変化する率を表している。 

右辺第 2 項は乱流エネルギーの乱流拡散を示す項であり、通常、勾配拡散の過程を用

いてモデル化される。 

 …(2.16) 

ここでμt は先に定義した渦粘性であり、σk は乱流プラントル数でその値は近似的に

一定とみなす。 

式(15)の右辺第 3 項は平均流により乱流エネルギーの生産率を示す項であり、平均流

から乱流成分への運動エネルギー輸送を示す項である。ここで、渦粘性の過程をレイ

ノルズ応力を評価するのに用いると、式(2.15)の右辺第 3 項は以下の様に記述する事

が出来る。 

 …(2.17) 

以上で乱流エネルギーの輸送方程式は、基地の計算値を用いて完全に解く事が出来る。 

一方、長さスケールの方程式の選択はあまり明らかではなく、多くの方程式が低産さ

れている。最も一般的なモデルでは、エネルギー方程式に散逸率が直接必要となる点

に着目し、所謂平衡状態の乱流、つまり乱れの生産と散逸の割合がほぼ釣り合ってい

るという関係を用いる。この時、エネルギー散逸率εと k と L は以下の様に関連付け

られる。 

 …(2.18) 

この考えは、高レイノルズ数流れでは、最大スケールから最少スケールへエネルギー

のカスケードが起きており、小さなスケールへの輸送されたエネルギーは散逸すると

いう事実に基づいている。式(2.18)は慣性領域でのエネルギー輸送の評価に基づいて

いる。 

この関係により。エネルギー散逸率εの輸送方程式を用いればεと L の両方が得られ

る事になる。完結したモデルでは、モデル定数は他の量と結びつける事が可能なので、

上式では定数は用いられない。 

エネルギー散逸率の正確な輸送法的式はナビエ・ストークス方程式から導く事が出来

るが、各項のモデル化が非常に難しいので方程式全体をモデルとしてみなす方法がよ

い。最も一般的に用いられているモデル近似式は以下の様になる。 

 …(2.19) 

このタイプのモデルでは渦粘性は以下の様に表される。 
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 …(2.20) 

この様に式 と に基づくモデルが k-εモデルと呼ばれており、幅広く用いられてい

る。このモデルには 5 つのパラメータが含まれており、一般的には以下の値が用いら

れる。 

 
k-ωSST モデルでは式が微調整され、以下の式を用いる。 

 …(2.20) 

 …(2.21) 

このモデルでは渦粘性を次の様に表される。 

 …(2.22) 

モデル係数については k-εと比較して幾分複雑であり、次の値が用いられる。 
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2.4.6 並列解析 

近年、単一プロセッサの計算能力の成長は足踏みしつつある。したがって、現在で

は計算速度のさらなる向上の為に複数のプロセッサを用いた並列計算機が必要と成

って来ている。従来のベクトルスーパーコンピュータに対する並列計算機の利点は

「サイズの拡張性」である。また、並列計算機では標準的なコンピュータチップを用

いる一般にコストが安い。商業的に利用可能な並列計算機の中には数千のプロセッサ、

テラバイトメモリ、テラフロップスの演算能力を有している場合もある。しかし、慣

用的な逐次計算機様に設計されたアルゴリズムでは、並列計算機上で効率よく作動し

ない可能性がある。 

もし、並列化をすべてのループ計算にたいして実行したならば、実質的に計算速度は

計算コードのもっとも効率的でない部分により決定するアムダール(Amdahl)の法則

に従う。よって、計算の効率を高くする為には計算コードの並列化出来ない部分を小

さくしなければならない。 

より良い方法は計算領域を小領域に分割して、それぞれの小領域に 1 つのプロセッサ

を割り当てる事である。この様な場合、同一の計算コードが全てのプロセッサ上で各

領域の一連のデータに対して実行される。各プロセッサは他の小領域のデータも必要

とするので、プロセッサ間のデータの交換若しくは重複したデータの保存が必要であ

る。 

 

2.4.7 抵抗係数 

解析結果の妥当性を検証する上で基準とした指標は抵抗係数である。抵抗係数は以

下の式 で計算する事が出来る。Cd は抵抗係数、D は抗力、ρ は密度、u は速度、A

は代表面積である。 

 …(2.23) 

また、解析値と理論式との比較をする際に使用する全圧の式は以下の式(2.24)である。 

  …(2.24) 
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2.5 解析条件及び解析手順 

2.5.1 解析条件 

2.5.1.1  船舶三種 

2.2.1 節で挙げた船舶三種の解析条件は以下の Table 2.1～2.4 である[8]。境界条件設

定に関する記述は、全て OpenFOAM-2.1.0 形式である。 

 

Table 2.2 : 船舶三種のモデル情報 

No. Name L (m) S(m
2
) V (m/s) Re (-) 

1 KRISO Container Ship (KCS) 7.2786 9.4379 2.196 1.4×10
7
 

2 Modified KRISO Tanker (KVLCC2M) 4.97 6.5892 0.994 3.945×10
6
 

3 US Navy Combatant, DTMB 5415 5.72 4.861 2.1 1.26×107 

 

Table 2.3 : 各種境界の境界条件 

  境界条件 

各種境界   k omega p u 

流入口 
type fixedValue; fixedValue; zeroGradient; fixedValue; 

vallue $internalField; $internalField;   uniform 

流出口 

type inletOutlet; inletOutlet; fixedValue; inletOutlet; 

inletValue $internalField; $internalField;   uniform (0 0 0); 

value $internalField; $internalField; $internalField; $internalField; 

仮想海洋壁面 
type slip slip slip; slip; 

value         

対称面 
type symmetryPlane;   symmetryPlane;   symmetryPlane;   symmetryPlane;   

value         

船体 
type kqRWallFunction; omegaWallFunction; zeroGradient; fixedValue; 

value $internalField; $internalField;   uniform 
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2.5.1.2  Audi TT 

2.2.2 節で挙げた Audi TT の解析条件は以下の Table 2.4, 2.5 である。境界条件設定に

関する記述は、全て OpenFOAM-2.1.0 形式である。 

また、今回使用した fvScheme 及び fvSolutions は Fig.2.6, 2.7 である。Fig2.6 では勾

配・発散・ラプラシアン・2 点間の値の補間方法を決定している。Fig.2.7 では解析の

解法・アルゴリズム・緩和係数を決定している。 

 

Table 2.4 : Audi TT のモデル情報 

No. Name L (m) S(m
2
) V (m/s) Re (-) 

1 Audi TT 4.188 2.3 30 1.09×10
7
 

 

Table 2.5 : Audi TT の境界条件 

  境界条件 

各種境界   k omega p u 

流入口 
type fixedValue; fixedValue; zeroGradient; fixedValue; 

vallue $internalField; $internalField;   uniform 

流出口 

type inletOutlet; inletOutlet; fixedValue; inletOutlet; 

inletValue $internalField; $internalField;   uniform (0 0 0); 

value $internalField; $internalField; $internalField; $internalField; 

仮想風洞 
type slip slip slip; slip; 

value         

路面 
type kqRWallFunction; omegaWallFunction; zeroGradient; fixedValue; 

value $internalField; $internalField;   uniform 

車体 
type kqRWallFunction; omegaWallFunction; zeroGradient; fixedValue; 

value $internalField; $internalField;   uniform 
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Fig.2.5 : fvSchemes 
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Fig.2.6 : fvSolutions 
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2.5.2 メッシュ生成及び並列化 

解析に使用したメッシュ形状は非構造格子(テトラ構造)である。乱流モデル k-ω

SST を使用する為、解析対象壁面周囲のメッシュ能解度は高く、対象壁面から離れる

につれ能解度は低くなる。メッシュの伸長率は、船舶三種に関しては 10～15 倍、Audi 

TT に関してはメッシュ数 1 億を満たす必要がある為 1.5 倍程とした。 

メッシュ生成時、最もメモリ使用量を要するプロセスはメッシュの出力である。船

舶三種用のメッシュは 4Gbyte を使用し出力時間は 5 分、対する Audi TT は搭載量全

ての 24Gbyte を占有し出力時間は 3～4 時間であった。 

船舶三種の解析に使用した領域の総メッシュ数は 200～400 万である為、並列解析

用の並列処理は行わなかった。対する Audi TT では、要素数が約 1 億 2 千万の為並列

化処理を行った。並列化処理に際し、OpenFOAM の並列化機能 decomposePar は単一

プロセッサによる機能しか持たない為、FX10 では無く Meisa で処理し、FX10 へデー

タを転送した。メッシュ数 1 億に対する 100 並列化の時間はおよそ 0.5 時間、使用メ

モリ量は搭載容量全ての 48Gbyte であった。 

 

2.5.3 乱流エネルギー・特殊散逸率の算出 

2.5.3.1  船舶三種 

船舶三種の乱流エネルギーの算出は、OpenFOAM ユーザーガイド[10]に記載されて

いる以下の式(2.25)及び(2.26)を用いた。また、特殊散逸率はソルバのデフォルト値で

ある 8.333 を使用している。 

 …(2.25) 

 …(2.26) 

ここで、U は主流速度である。 
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2.5.3.2  Audi TT 

Audi TT の乱流エネルギー及び特殊散逸率の算出は、CFD Online
[11]が提供する資料

を元に以下の式を用いた。 

 …(2.27) 

 …(2.28) 

 …(2.29) 

 

ここで、U は主流速度、I は乱流長さスケール、 で、 は以下の式(2.30)を

用いた。 

 …(2.30) 

は各方向の速度の 3.5％である。 

 

2.5.4 解析の実行 

2.4.1 節及び 2.4.2.節の処理後、OpenFOAM による解析を行った。解析は時間変化を

考慮しない定常解析で、OpenFOAM 上では simpleFoam と呼ばれる。解析に要した時

間は 3 節の解析結果で述べる。 

 

2.5.5 解析結果の可視化及び妥当性検証 

2.4.3 節で行った解析の結果に関する妥当性を検証する為に、抵抗係数の参考値と解

析値を比較した。 

船舶三種に関しては参考値に対して 10
-4オーダー迄合致した場合、解析が妥当であ

ると判断するものとした。Audi TT に関しては参考値に対して±0.1 程度の誤差を許容

し、これに当てはまる場合は解析が妥当であると判断するものとした。 
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第3章 解析結果 

3.1 船舶三種 

第一段階として解析した船舶三種の解析結果について、各々の抵抗係数解析の推移

と圧力コンターを以下に示す。Fig.3.1, 3.4, 3.7 はそれぞれの船舶の抵抗係数解析結果、

Fig3.2, 3.5, 3.8 はそれぞれの船舶周辺の圧力分布、Fig3.3 , 3.6 , 3.9 はそれぞれの船舶周

辺の速度分布である。Fig.3.3 及び Fig.3.6 は、流れが x 軸負方向の為、最大流速が負

表示と成って居る。 

解析に要した時間は約 1 日、可視化に要した時間は 30 秒であった。 

 

3.1.1 KRISO Container Ship (KCS) 

 

Fig.3.1 : KRISO Container Ship (KCS)の抵抗係数解析結果 
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Fig.3.2 : KRISO Container Ship (KCS)の圧力分布 

 

 

Fig.3.3 : KRISO Container Ship (KCS)の速度分布 
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3.1.2 Modified KRISO Tanker (KVLCC2M) 

 

Fig.3.4 : Modified KRISO Tanker (KVLCC2M)の抵抗係数解析結果 

 

 

Fig.3.5 : Modified KRISO Tanker (KVLCC2M)の圧力分布 
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Fig.3.6 : Modified KRISO Tanker (KVLCC2M)の速度分布 
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3.1.3 US Navy Combatant, DTMB 5415 

 

Fig.3.7 : US Navy Combatant, DTMB 5415 の抵抗係数解析結果 

 

 

Fig.3.8 : US Navy Combatant, DTMB 5415 の圧力分布 
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Fig.3.9 : US Navy Combatant, DTMB 5415 の速度分布 
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3.2 Audi TT 

FX10(Oakleaf-FX)による Audi TT の解析結果を以下に示す。Fig.3.10 は抵抗係数の解

析結果、Fig.3.11～3.13 : は、抵抗係数 0.29 時の圧力コンターである。 

Fig.3.14～3.17 は速度表示の流線である。今回、CAD データにおいて z 軸方向の正

負を反転させる事が出来なかったので、カラーバーの流速表示が逆と成っている。本

流線図において最速は 43.959m/s、最遅は 1.686m/s である。 

解析時間に要した時間は約 30 時間、可視化に要した時間は約 40 分であった。 

 

Fig.3.10 : Audi TT の抵抗係数解析結果 
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Fig 3.11 : Audi TT 周辺の圧力分布 

 

 

Fig.3.12 : Audi TT 前方の圧力分布 
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Fig.3.13 : Audi TT 後方の圧力分布 

 

 

Fig.3.14 : Audi TT 周辺の速度流線 
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Fig.3.15 : Audi TT 周辺の速度流線 

 

 

Fig.3.16 : Audi TT 前方の速度流線 
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Fig.3.17 : Audi TT 後方の速度流線 
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第4章 妥当性の検証 

解析を行った船舶三種及びAudi TTに関して、抵抗係数の参考値と解析値を比較し、

動圧の式より得られるよどみ点圧と解析結果から得られたよどみ点圧を比較した。 

 

4.1 船舶三種 

4.1.1 KRISO Container Ship (KCS) 

抵抗係数の参考値[8]
0.00356 に対して解析から得られた抵抗係数は 0.00355 となり、

参考値と解析値は 10
-4オーダー迄合致して居る。また、動圧の式より式(4.1)からよど

み点圧は 2.413Pa と計算出来るのに対し、解析値は 2.427Pa である事から、この解析

は妥当であると考えられる。 

 …(4.1)  

 

4.1.2 Modified KRISO Tanker (KVLCC2M) 

抵抗係数の参考値[8]
0.00355 に対して解析から得られた抵抗係数は 0.00355 となり、

参考値と解析値は 10
-4 オーダー迄合致して居る。また、動圧の式よりよどみ点圧は

0.494Pa と計算出来るのに対し解析値は 0.489Pa である事から、この解析は妥当である

と考えられる。 

 …(4.2) 

 

4.1.3 US Navy Combatant, DTMB 5415 

抵抗係数の参考値[8]
0.00423 に対して解析から得られた抵抗係数は 0.00425 となり、

参考値と解析値は 10
-4オーダー迄合致して居る。また、動圧の式より式(4.3)からよど

み点圧は 2.205Pa と計算出来るのに対し解析値は 2.435Pa である事から、この解析は

妥当であると考えられる。 

 …(4.3) 
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4.2 Audi TT 

抵抗係数の参考値 0.3 に対して解析から得られた抵抗係数は 0.29 となり、参考値と

解析値は±1 の範囲で合致して居る。また、動圧の式より式(4.4)からよどみ点圧は

450Pa と計算出来るのに対し解析値は 467.296Pa である事から、この解析は妥当であ

ると考えられる。 

 …(4.4) 

 

4.3 本解析の実用性 

プリプロセス・ソルバー・ポストプロセス全体において要した時間は、以下の Table 

4.1 の通りである。 

Table 4.1 : 各種解析に要した時間 

  船舶三種 Audi TT 

プリプロセス 10分 4日 

ソルバー 1日 2日 

ポストプロセス 1分 1日 

 

Table 4.1 において、特にプリプロセスは作業者のノウハウや技術によって差が生じる

ものの、最長時間である Audi TT を見ても凡そ 1 週間である事から、作業時間全体は

現実的な物であると考えられる。 
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第5章 結論 

1. 第 1 章 Table 3「Aventador」のスペックで、要素数約 1 億 2 千万のメッシュを生成

出来る事が分かった。 

 

2. 第 1 章 Table 2「FX10 (Oakleaf-FX)」のスペックで、要素数約 1 億 2 千万のメッシ

ュを 100 並列で解析出来る事が分かった。 

 

3. 第 1 章 Table 3「Aventador」のスペックで、要素数約 1 億 2 千万の解析結果を可視

化出来る事が分かった。 

 

4. 要素数約 1 億 2 千万のプリプロセス・ソルバー・ポストプロセス全体で約 1 週間

掛かる事が分かった。 

 

5. 本研究室のリソース全てを以て、要素数約 1 億 2 千万の解析を行える事が分かっ

た。 
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1. はじめに (必読) 

本マニュアルは、本研究室で CFD による流体シミュレーションを円滑に行える

様に基本的な作業を説明した物です。プリプロセスは CFD Workshop Tokyo 2005

に掲載されている 3 種類の船舶に関する物を中心します。ソルバーは Audi TT 8J

の様な大規模解析を中心に進めていきます。メッシュジェネレータ「Pointwise」、

可視化ソフト「Fieldview」、小規模解析におけるソルバーの取り扱いは、各種ソフ

トウェアマニュアルを参考にして下さい。 

 

 

2. 使用ソフトウェアと環境 

2.1 使用ソフトウェア 

・Pointwise (メッシュジェネレーター) 

・OpenFOAM (熱流体解析ソルバ) 

・Fieldview (可視化ソフト) 

 

2.2 環境 

・Aventador (新宿 1823 室の Windows 7 64bit) 

・Meisa, Sayuri, Stewart (Linux ベースの解析サーバー) 

・FX10-Oaklef-FX (国立大学法人東京大学所有のスーパーコンピュータ) 

 

 

Fig.2.2.1 : Aventador       Fig.2.2.2 : FX10 (Oakleaf-FX) 
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3. プリプロセス(メッシュ生成) 

3.1 下準備 

3.1.1 CAE 選択及び CAD データの確認 

本マニュアルで使用する船体は KVLCC2M とします。 

メッシュ生成の下準備として最初に行うべき作業は「ソルバー選択」

及び「CAD データの確認」です。解析対象となる CAD データは当てに

成らない部分が多い為、この作業は必ず行う必要があります。 

さて、まず初めに Pointwise を起動し、[CAE]→[Select Solver]と進み、

使用するソルバーを選択します。 

続いて[File]→[Import]→[Datebase]と進み、解析対象と成る CAD デー

タ(IGES 形式が望ましい)をインポートしましょう。Fig.3.2.1 の様に、イ

ンポートした CAD データがピンクとグレーの線で描かれている事だと

思います。これがメッシュ生成のベースと成る重要な情報に成ります。 

 

 

Fig.3.2.1 : CAD データインポート画面 

 

次に、船体を半分に切りましょう。こうする事による、解析対象領域

を減らし、解析時間を短縮する事が出来ます。船体の半分をドラッグで

選択し、Delete キーを押す事で削除できます。 
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3.1.2 修正 

さぁ、残った船体の面と面との接続部分を見てみましょう。船体を

半分に切る接続部分を拡大していくと、所によっては僅かに面同士が

離れ、お互いが完全に接続されて居ない場合があると思います。この

部分を放置してしまうと往々にしてメッシュを生成出来ないので、本

節で CAD データの修正方法を学びましょう。 

早速データベース(ピンク色の線)を操作して修正を行いたいと思う

かもしれませんが、この操作は推奨しません。データベースというの

は一見すると「ただの枠線の集合」と考えがちですが、枠線で囲まれ

た部分は目に見えない形状のデータ(曲面等)を持っています。データ

ベースを操作し過ぎると、大切な曲面データ迄消去してしまう可能性

がある為、先ずはコネクタを張りましょう。[Defaults]タブで[Average 

Δs]に任意の平均格子幅を入力し、データベース全てを選択してコネ

クタ生成ボタンをクリックします。コネクタ生成後は Fig.3.2.2 コネク

タを張ると緑色の線が現れる事でしょう。このコネクタを元に、メッ

シュのベースと成るドメインを生成して行く事になります。その後、

各接続部分を拡大して面の接続具合を確認していきます。例えば、今

回の船体では Fig3.2.3 の丸部分に接続されて居ない部分があります。 

 

 

Fig.3.2.2 : コネクタ生成ボタン 

 

 

Fig.3.2.3 : コネクタ生成後 
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Fig.3.2.4 : 面の不一致 

 

接続されて居ない部分を修正する為に、「Merge 機能」を使用します。

「Merge 機能」とは、接続されて居ないコネクタ同士を接続させる機能

です。全コネクタを選択し[Grid]→[Merge]と進みます。すると画面左の

部分に[Auto Merge][Merge by picking]などが表示される事でしょう。ここ

で使用するのは[Auto Merge]の[Tolerance]です。初期値では Tolerance は 0

に成っていると思います。ここでは値を 0.1 に設定し、Enter と操作して

下さい。そして[Apply]をクリックすると、接続されて居なかったコネク

タ同士が接続されている筈です。これが確認出来たら[OK]をクリックし

ましょう。万が一、未だコネクタ同士が一致して居ない場合はトレラン

スの値を大きくし、再度確認を行います。接続後は Fig.3.2.4 の様に成り

ます。 
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Fig.3.2.5 : コネクタ同士の接続 
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3.1.3 注意点 

3.2.2 節で説明した[トレランス]の値ですが、これは大きくし過ぎると

最悪の場合、面のデータそのものが消失してしまう場合があります。こ

う成ってしまった場合は Undo で修正作業を行う前に戻しましょう。 

[Merge]機能を用いても面同士の接続を修正出来ない場合は力づくで

修正を行います。完全に接続されていない面同士の隙間を拡大するとコ

ネクタを二本確認できると思います。この場合、片方のコネクタを削除

し、隙間を埋める様に手作業でコネクタを張り「一枚の面」とします。 
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3.2 ドメイン生成 

さ て、修正したデータベースに、メッシュの元となる「ドメイン」を生成

します。 

全てのコネクタを選択し、Fig.の Unstructured をクリックし、Fig.の Domeins on 

Datebase Entities をクリックします。すると、Fig.3.3.1 の様な状態に成る事で

しょう。 

 

Fig.3.3.1 : ドメイン生成後 

 

これでドメインの生成は完了です。 
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3.3 面同士の結合 

本節の「面同士の結合」で表面整状は終了と成ります。 

3.3 節迄で作成したドメインを全て選択し、[Edit]→[Join]と進みましょう。こ

れにより面が全て一致する筈です。 

ここで、[Edit]→[Join]と進んだにも関わらず面が一致しない場合があります。

その場合は 2 つの面を選択し[Join]、結合された面と別の面を選択し[Join]、と

同様の操作を繰り返して下さい。この作業は成功しない場合が多々あります。

これは Pointwise と IGES ファイルとの親和性等により引き起こされるもので

すので、何度同様の作業を行っても成功しない場合は Pointwise 自体を再起動

する事を推奨します。接続後は Fig3.4.1 と成ります。 

 

 

Fig.3.4.1 : 面同士の結合後 
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3.4 仮想水槽生成 

3.4 節で CAD データの準備は終了しました。次に解析領域と成る水槽(風洞)

を生成します。 

一般に、船舶の解析では解析領域のサイズを船体に対して「前方 1.5 倍」「後

方 2 倍」「側方 1.5～2 倍」と定義しています。念の為に少し大きめに領域を

取っておくと良いでしょう。 

さて、先ずは船体の先端から前方にコネクタを張ります。コネクタ生成ボ

タンをクリックし船舶の先端を選択、必要な長さを入力し、Apply をクリッ

クします。同様に船舶後方も処理します。 

次に領域の側面を作ります。同様にコネクタ生成ボタンをクリックし、先

ほど生成したコネクタの先端を選択、必要な長さを入力し、Apply をクリッ

クします。同様にして船体を囲う様にコネクタを生成する事で、解析領域を

作成する事が出来ます。 

続いて、作成したコネクタ群を用いてドメインを生成します。作成したコ

ネクタのみを選択し、[Grid]→[Dimensions]を選択します。そして[AverageΔs]

を選択し、適宜数値を入力します。これによりドメインを生成する為に必要

な平均格子幅を定義出来ます。 

 

 

Fig.3.5.1 : 仮想水槽コネクタ生成後 
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最後に、各面を囲う様にコネクタを選択し、ドメインを生成します。図の

様にコネクタを選択し、ドメイン生成ボタンをクリックしてください。これ

を各面に行う事で解析領域全ての情報を作成出来ます。結果は Fig.3.5.2 の様

に成ります。 

 

 

Fig.3.5.2 : 仮想水槽ドメイン生成後 

 

3.5 メッシュ生成 

3.5 節迄に生成したドメイン群により、メッシュを生成する事が出来ます。 

先ず、全てのドメインを選択しブロック生成ボタンをクリックして下さい。

これにより Pointwise に解析領域を認識させます。 

続いて、認識させたブロックを選択し、Initialize ボタンをクリックして下

さい。これでメッシュ生成が始まります。 

 

Fig.3.6.1 : Initialize ボタン 
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3.6 境界条件設定 

3.6 節で見事メッシュを生成出来た事でしょう。最後の処理は境界条件設定

です。 

先ずは設定したい境界条件の種類を準備しておきましょう。今回は「流入口

(inlet)」「流出口(outlet)」「船体壁面(wall)」「解析領域壁面(sidewall)」とします。

Pointwise ではアルファベットで境界条件の名前を設定しますが、その名前は

自由に決めてもらって構いません。自分が分かるものを設定しましょう。 

さて、境界条件設定を行います。[CAE]→[Set Boundary Conditions]と進み、

Fig.3.7.1 の境界条件設定画面へ移ります。先ず[New]をクリックし、新たな境

界名を作成します。今回の場合、流入口は[inlet]、流出口は[outlet]、対称面は

[symmetlyPlane]、仮想海洋壁面は[seawall]、船体は[wall]と名付けます。また、

Type 設定については、流入口及び流出口を[patch]、仮想海洋壁面及び船体は

[wall]、対称面は[symmetlyPlane]を選択します。設定後は Fig の様に成ります。 

 

Fig.3.7.1 : 境界条件設定画面 



 

51 

次に、メッシュへ境界条件情報を設定します。メッシュ画面において流入

口としたい面を選択した後、画面左の[inlet]と設定した列のチェックボックス

をクリックします。これを繰り返す事で、メッシュへ境界条件を設定する事

が出来ます。 

 

Fig.3.7.2：境界条件設定後 

 

以上の設定が終了したら、[Close]をクリックします。 

 

3.7 出力 

3.7 節でメッシュの生成は終了しました。最後にメッシュの出力をしましょ

う。 

[List]タブのブロックを選択し、[File]→[Export]→[CAE]と進み、出力場所を

選択する事でメッシュを出力する事が出来ます。 
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4. ソルバー (解析) 

さて、それではソルバーへ移ります。ここでは先の述べた通り、大規模解析を

行う事を想定した FX10(Oakleaf-FX)の取り扱いを中心に説明します。先ずは前節

迄で完成したメッシュの並列処理から説明します。 

 

4.1 並列処理 

一般に、1 コアで要素数約 10
6の解析を行う事が効率的であると言われてい

る様です。例えば、本研究では要素数約 12
8 なので 120 並列にすると良いで

しょう。この様に、要素数を元に並列数を決定して、大規模並列解析の準備

を行いましょう。 

さて、本来であれば並列処理も全て FX10 で行いたい所ですが、並列化処

理をしてくれる OpenFOAM の機能[decomposePar]は使用可能ノード全てを用

いた処理をしてくれません。これは単独ノード上での処理に限られるので、

要素数 12
8 は到底扱いきれません。しかし、本研究室には「Meisa」「Sayuri」

「Stewart」と言った頼もしいサーバーが居ます。そこで、並列化処理は彼ら

の力を借りて作業を進めましょう。 

 

4.1.1 メッシュ転送 (メッシュ生成 PC→研究室サーバー) 

この段階については「流体工学セミナー 追加演習」を受講した同級

生に質問して下さい。 
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4.1.2 decomposeParDict 

並列化を行う際、system 直下へ decomposeParDict と言うディクショナ

リを置く必要があります。以下の参考と成るディクショナリ内の記述を

記載します。本サンプルは要素数約 12
8、120 並列化を想定しています。 

/*--------------------------------*- C++ -*----------------------------------*¥ 

| =========                 |                                         | 

| ¥¥      /  F ield         | OpenFOAM: The Open Source CFD Toolbox      | 

|  ¥¥    /   O peration     | Version:  2.0.1                              | 

|   ¥¥  /    A nd           | Web:      www.OpenFOAM.com            | 

|    ¥¥/     M anipulation  |                                           | 

¥*---------------------------------------------------------------------------*/ 

FoamFile 

{ 

    version     2.0; 

    format      ascii; 

    class       dictionary; 

    location    "system"; 

    object      decomposeParDict; 

} 

// * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * // 

 

numberOfSubdomains 120; 

 

method          hierarchical; 

 

simpleCoeffs 

{ 

    n               ( 4 5 6 ); 

    delta           0.001; 

} 

 

hierarchicalCoeffs 

{ 

    n               ( 4 5 6 ); 

    delta           0.001; 

    order           xyz; 

} 
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manualCoeffs 

{ 

    dataFile        ""; 

} 

 

distributed         no; 

 

roots               ( ); 

 

 

// ************************************************************************* // 

 

 

この様式を崩さず、数値を変更する事で確実に並列化する事が出来ます。

各種設定部分の説明はユーザーマニュアルに一任します。 
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4.1.3 decomposePar 

さて、4.1.2 節が終了したら[decomposePar]コマンドを実行し、並列化

します。12
8では約 1.5 時間程掛りますが、彼らも全力で頑張ってくれま

す。我慢しましょう。 

その際、並列化では彼らのメモリを全て使用する事に成りますので、同

級生の解析が回っている場合は並列化する事を伝え、念の為に並列化実

行時は全解析を切って貰いましょう。 

 

4.1.4 メッシュ転送 (研究室サーバー→FX10) 

彼らの頑張りにより並列化が終了した事でしょう。この段階でも同様

に並列化されたものを含む全データを Windows OS へ吸出し、これを

FX10 へ転送して下さい。 
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4.2 ジョブ準備 

続いては FX10 で解析(ジョブ)を行う際に必要な準備を行います。FX10 の

初期作業は東京大学 情報基盤センターHP を参考に行って下さい。 

 

4.2.1 ジョブ記述 

FX10 は、本研究室の彼らとは異なる方法で仕事を受託します。0, 

constant, system, processor 1, processor 2 …等が並んでいる階層へ「○

○.sh」というジョブファイルを置きます。以下に○○.sh の参考記述を

記載します。○○部は任意に設定しましょう。私は定常解析を行う

simpleFoam のジョブを要したので、simpleFoam.sh と設定しました。以

下のジョブ記述も同様に 120 並列を想定してします。 

 

#!/bin/sh 

#PJM -L "rscgrp=regular" 

#PJM -j 

#PJM -L "node=12" 

#PJM --mpi "proc=120" 

#PJM -L "elapse=48:00:00" 

cd $PJM_JOBDIR 

mpirun -np 120 simpleFoam -parallel 

 

ノード数及び解析時間の設定は前述の通り、情報基盤センターHP を参

考にして下さい (全部書いてたら卒論提出間に合わない)。 

 

4.2.2 –interact 

ジョブ内容を記述したファイルを準備したら、interactive node へ移動

します。 

Putty.exe を起動し、[--interact]と入力して interactive node へ移動しまし

ょう。 
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4.2.3 実行 

Interactive node へ移動したら、解析を行いたいディレクトリへ移行し、

解析を実行します。これはターミナルへ、4.2.1 節で設定したジョブの名

前(simpleFoam.sh 等)を指示する事で解析が開始されます。 

 

4.2.4 ログ追尾 

並列解析を行うと、解析経過を確認する事が出来ません。そこでログ

ファイルをリニアに表示するコマンドを使用して解析経過を追っかけ

ましょう。ターミナルへ[tail -f -n 20 ○○]と指示する事で解析を追尾す

る事が出来ます。但し、○○はジョブを投入した際に生成されるファイ

ルの名前（例えば simpleFoam.sh.[数字の羅列]）を指定します。 
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5. ポストプロセス (可視化) 

最後は解析結果の可視化を行うポストプロセスです。これを以て解析は終了し

ます。ここでは 

5.1 インポート 

OpenFOAM の解析結果を、Fieldviewがインストールされている WindowsPC

へ転送します。インポートしたディレクトリに「○○.foam」と名付けたファ

イルを生成します。その後、Fieldview を起動し、 [File]→ [Date Input]→

[OpenFOAM Direct Reader]と進み、[Read Grid & Result Date]を選択し、先ほど

生成した「○○.foam」を選択します。 

 

5.2 各種境界表示 

此処では、各種境界を表示します。画面左バー内の[Bound]を選択します。

[Create]をクリックし、[Boundary Types]から任意の境界を選択します。圧力等

の解析結果を適用したい場合は[Scalar Fanction]で任意のデータを選択し、

[COROLING]のラジオボタンを[Scalar]にします。 

 

カラーバーを表示させたい場合は、[Colormap]タブを選択し任意のコンター

を選択した後、[Legend]タブで[Show Legend]を選択します。 
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Fig.5.2.1 : Boundary Surface 
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Fig.5.2.2 : Colormap 
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Fig.5.2.3 : Legend 
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5.3 流線表示 

流線を表示させる場合は、画面左バーの[Stream]を選択します。[Create]を

クリックし、[Scalar Function]で任意の解析結果を選択します。[COLORING]

で[Scalar]を選択しておきましょう。 

次に、流線表示のベースと成るシード点を置きます。流線を表示させたい

端点の座標を[X:][Y:][Z:]に入力し、[Mode:]が[Add]である事を確認して[OK]

をクリックします。同様に片方の端点も入力しましょう。次に、[Mode:]を[Add 

Between]にし、両端点の間に表示させたい流線の本数を[Seeds to Add:]に指定

します。その後、[Seed:]の番号を[1]にして[OK]、続いて[2]にして[OK]をクリ

ックし、再度[OK]をクリックします。[Show Seeds]にチェックを入れれば、流

線が表示されます。 

 

各種表示結果は、卒業論文の第 3 章を見て下さい。 



 

63 

 

Fig.5.3.1 : Streamline 1 
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Fig.3.2.2 : Streamline 2 

 

以上、本マニュアルが、皆様の研究の力に成れる事を願って居ります。 

不明点がある場合は先生方へ私の連絡先を問い合わせ、御連絡下さい。 
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